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MARC Magician Professional
has several features to assist
with cataloging, including a robust
Help section and the Auto Error
Checking function.

This overview gives a basic outline of
these features and how to use them.

For more detailed information, see the
“MARC Magician User's Guide”
available for review or download HERE.
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Help Features

From the Main Window, access Help using either the Help Menu or the
Help button from the navigation bar.

L File

Edit View Record List Select User Templafe Window Help

e [o|@jal-| & a4 ¥ 2|

A..] Author [ Titie [ Year [ Template [ Call Number [ Bar Code [ subject [ Export Status [ Export Date | Import Batch | Import Date | Imported By [ Import Repairs [ Creation Date | Created By [ Update Date | Updated B -
o The answer-backer cure [gideore... 1994 [J Videor.. E MCD 501132100003.... Conduct of life.; Videos for the... New Batch 1 10/7/2013 9:... User 1 10 10/07/13 09:... User 1
ox The best American short stories ... 1999 [3 Book ( Short stories, American.; Am... New Batch 1 10/7/2013 9... User 1 10 10/07/13 09:... User 1
o FOR [gideorecording] : fear itself (... 1994 [ Videor. Roosevelt, Franklin D. (Frankii.. New Batch 1 10/7/2013 9:... User 1 6 10/07/43 09:... User 1
o FOR [gideorecording] - the center... 1994 [ Videor. Roosevelt, Franklin D. (Frankii... New Batch 1 10/7/2013 9:... User 1 6 10/07/43 09:... User 1
o FDR [gideorecording] : the grand... 1994 [J Videor. Roosevelt, Franklin D. (Frankli... New Batch 1 10/7/2013 9.... User 1 6 10/07/43 09:... User 1
o FOR [gideorecording] - the juggler... 1994 [ Videor. Roosevelt, Franklin D. (Frankii... New Batch 1 10/7/2013 9:... User 1 6 10/07/43 09:... User 1
o From the heart - true stories by A... 1997 [ Book (. Nursing - Australia.; True stor... New Batch 1 10/7/2013 9:-... User 1 4 10/07/13 09:... User 1
ox Joumey to Kilimanjaro [gideoreco... 1994 [ Videor.. 508.678 JOU 501132100004... Natural history ~ Tanzania — ... New Batch 1 10/7/2013 9:... User 1 11 10/07/13 09:... User 1
o Lightning! [gideorecording] / WG... 1995 [J Videor.. 551.5LIG  501132100004... Lightning. New Batch 1 10/7/2013 9-... User 1 10 10/07/43 09:... User 1
o The sign of the beaver [gideorecor... 1997 [ Videor.. F SPE pt.1;... 501132100005... Frontier and pioneer life - Mai... New Batch 1 10/7/2013 9:... User 1 13 10/07/13 09:... User 1
ax There’s a nightmare in my closet ... 1992 [3 Videor.. E MAY 501132100005... Monsters -- Fiction_; Videos f.. New Batch 1 10/7/2013 9:... User 1 " 10/07/13 09: User 1 =
o True stories : stories by uncomm... 1997 [ Book ( Women authors.; True stories... New Batch 1 10/7/2013 9-... User 1 5 10/07/43 09:... User 1
o The universe within [gideorecordin... 1995 [J Videor.. 574.1 UNI  501132100005... Videos for the deaf.; Human p... New Batch 1 10/7/2013 9:... User 1 11 10/07/13 09:... User 1
ax The unknown world [gideorecordi 1996 [ Videor.. 576 UNK 501132100005.... Videos for the deaf.; Microorg... New Batch 1 10/7/2013 9:... User 1 10 10/07/13 09: User 1
@& Achebe, Chinua  Anthills of the savannah / Chinua ... 1988 [ Book (. Nigeria - Politics and govern... New Batch 1 10/7/2013 9:... User 1 4 10/07/43 09:... User 1
@ Achebe, Chinua  Arrow of God / Chinua Achebe. 1974 [ Book (. Igbo (African people) - Fiction... New Batch 1 10/7/2013 9-... User 1 4 10/07/43 09:... User 1
@% Achebe, Chinua A man of the people / Chinua Ac... 1966 [3 Book ( Nigeria -- Politics and govern... New Batch 1 10/7/2013 9:... User 1 5 10/07/13 09:... User 1
@ Achebe, Chinua  No longer at ease / Chinua Achebe. 1994 [J Book (. Nigeria — Lagos - Fiction.; Ig... New Batch 1 10/7/2013 9:... User 1 6 10/07/43 09:... User 1
@ Achebe, Chinua  Things fall apart 1959 [ Book ( Igbo (African people) - Fiction... New Batch 1 10/7/2013 9:... User 1 4 10/07/43 09:... User 1
ox ADAMS HITCHIKER'S GUIDE TO THE G... 1979 [J Book (.. PB FIC ADA 10053 Science fiction.; Juvenile fictio... New Batch 1 10/7/2013 9:... User 1 3 10/07/13 09:... User 1
@x ADAMS LIFE, THE UNIVERSE AND EVE... 1982 [J Book (. PBFICADA 32410;32411  HITCHHIKER'S QUARTET.; S... New Batch 1 10/7/2013 9:... User 1 3 10/07/43 09:... User 1
ax ADAMS THE RESTAURANT AT THE EN... 1980 [J Book (.. PBFICADA 32406; 32407 HitchhikerS quartet.; SCIENC... New Batch 1 10/7/2013 9:... User 1 6 10/07/13 09:... User 1
ox ADAMS SO LONG, AND THANKS FORA... 1984 [3 Book (.. PBFICADA 32409 HITCHHIKER'S QUARTET.; S... New Batch 1 10/7/2013 9:... User 1 3 10/07/13 09:... User 1
@ ADAMS, DOUG... THE HITCHHIKER'S GUIDE TO T. [ Comp... PBFICADA 4§12; 46473  SCIENCE FICTION.; HUMOR.... New Batch 1 10/7/2013 9:... User 1 4 10/07/43 09:... User 1
@ Alexander Beggar queen [ Book (. PB FICALE 1403 Adventure stories.; Juvenile fic... New Batch 1 10/7/2013 9:... User 1 1 10/07/13 09:... User 1
@ Alexander Black cauldron 2/prydain chronicl... 1965 [J Book (.. PB FIC ALE 36324; 36325;... Fantasy.; Juvenile fiction.; Sci... New Batch 1 10/7/2013 9:... User 1 2 10/07/13 09:... User 1
@x ALEXANDER  THE BOOK OF THREE 1/PRYD... 1964 [J Book (. PBFICALE 36330; 36331;... FANTASY.; FAIRY TALES. j... New Batch 1 10/7/2013 9-... User 1 4 10/07/43 09:... User 1
o% ALEXANDER  THE CASTLE OF LLYR 3/PRYD... 1966 [J Book (. PBFIC ALE 36327; 36328;... FANTASY.; PRINCES AND P... New Batch 1 10/7/2013 9:... User 1 4 10/07/13 09:... User 1
@ ALEXANDER  THE HIGH KING 5/PRYDAIN CH... 1968 [3 Book (.. PBFIC ALE 36321; 36322;... FANTASY.; juvenile fiction.; S... New Batch 1 10/7/2013 9:... User 1 4 10/07/13 09:... User 1
ox ALEXANDER  KESTREL [ Book (.. PBFICALE 2590 Adventure stories.; juvenile fic... New Batch 1 10/7/2013 9:... User 1 1 10/07/13 09.... User 1
ox ALEXANDER  TARAN WANDERER 4/PRYDAL.. 1967 [J Book (. PBFICALE 36333; 36334;... FANTASY.; Fairy tales.; juven... New Batch 1 10/7/2013 9:... User 1 2 10/07/13 09:... User 1
o ALEXANDER  WESTMARK [ Book (. PB FICALE 3645 Adventure stories.; juvenile fic... New Batch 1 10/7/2013 9:... User 1 1 10/07/13 09:... User 1
@ ALEXANDER, L... THE JEDRA ADVENTURE. 1989 [) Book (. PBFICALE 40357;40358  juvenile fiction.; Science Ficti... New Batch 1 10/7/2013 9:... User 1 4 10/07/43 09:... User 1
@ Alexander, Lioyd The Remarkable Jouney of Princ... 1991 [J Book (. PB FIC ALE  37533; 37534;... juvenile fiction.; Science Ficti... New Batch 1 10/7/2013 9:... User 1 4 10/07/13 09:... User 1
@ ANTHONY CASTLE ROOGNA 3/MAGIC O... 1979 [J Book (.. PBFICANT 36480; 36481  FANTASY.; juvenile fiction.; S... New Batch 1 10/7/2013 9:... User 1 3 10/07/13 09:... User 1
@ ANTHONY CENTAUR AISLE 4/MAGIC OF ... 1981 [J Book (.. PB FIC ANT 36484; 36485  FANTASY.: juvenile fiction.; S... New Batch 1 10/7/2013 9:... User 1 3 10/07/43 09:... User 1
@% ANTHONY CREWEL LYE; A CAUSTIC YAR... 1984 [J Book (. PBFICANT 2615;36489  FANTASY.; Adventure stories... New Batch 1 10/7/2013 9:... User 1 3 10/07/13 09:... User 1
@ ANTHONY DRAGON ON A PEDESTAL 7/M... 1983 [J Book (.. PB FIC ANT 36478; 36479  FANTASY.; juvenile fiction.; S... New Batch 1 10/7/2013 9:... User 1 3 10/07/13 09:... User 1
@ ANTHONY GOLEM IN THE GEARS 9/MAGI. [ Book (.. PB FIC ANT 2614 FANTASY.; Adventure stories... New Batch 1 10/7/2013 9.... User 1 2 10/07/43 09:... User 1
@ ANTHONY NIGHT MARE 6/MAGIC OF XAN... 1982 [J Book (.. PB FIC ANT 36486; 36487;... FANTASY.; Adventure stories... New Batch 1 10/7/2013 9:... User 1 3 10/07/13 09:... User 1
@ ANTHONY OGRE, OGRE 5/MAGIC OF XAN... 1982 [J Book (.. PBFIC ANT 36482; 36483 ~ FANTASY.. juvenile fiction.; S... New Batch 1 10/7/2013 9:... User 1 3 10/07/13 09:... User 1
@ Anthony THE SOURCE OF MAGIC 2/MA... 1979 [ Book (.. PB FIC ANT 36490; 36491  FANTASY.; Adventure stories... New Batch 1 10/7/2013 9:... User 1 5 10/07/43 09:... User 1
@ ANTHONY A SPELL FOR CHAMELEON 1/... 1977 [3 Book (.. PBFIC ANT 32631 FANTASY.; juvenile fiction.; S... New Batch 1 10/7/2013 9:... User 1 5 10/07/13 09:... User 1
@ Amstrong Sounder in uzbekistan 1969 [ Book (.. PB FIC ARM 32625; 32626;... DOGS - STORIES.; juvenile fi... New Batch 1 10/7/2013 9:... User 1 2 10/07/13 09:... User 1
ox ATWATER MR. POPPER'S PENGUINS. 1938 [ Book (.. PB FIC ATW 32792 CLASSIC.; PENGUINS - STO... New Batch 1 10/7/2013 9:... User 1 1 10/07/43 09:... User 1
@x BAUER ON MY HONOR 1986 [J Book (. PB FIC BAU 8145 PROBLEM NOVEL.; OBEDIE.... New Batch 1 10/7/2013 9:... User 1 2 10/07/43 09:... User 1
e BELLARS THE HOUSE WITH A CLOCK IN ... 1973 [3 Book (.. PB FIC BEL 32467 MAGIC - FICTION.; juvenile fic... New Batch 1 10/7/2013 9-... User 1 4 10/07/13 09:... User 1
ex BLOS A GATHERING OF DAYS: ANE... 1979 [J Book (. PBFICBLO 34698; 41817  DIARIES.; NEW HAMPSHRR... New Batch 1 10/7/2013 9:... User 1 4 10/07/13 09:... User 1
@ Bolanos, Jorge ... 100 Exitos Musicales : Album 1, ... 1968 [J Book (.. 785.4 BOL  T0006606 Spanish Language - Bolanos,... New Batch 1 10/7/2013 9:... User 1 6 10/07/13 09:... User 1
e BOND STRING IN THE HARP 1976 [ Book (.. PB FIC BON 42406; 42407  SPACE AND TIME - FICTION... New Batch 1 10/7/2013 9:... User 1 2 10/07/13 09:... User 1
@x BOSTON THE CHILDREN OF GREEN KN... 1955 [J Book (.. PB/FIC BOS 36306; 36307;... GREAT BRITAIN - FICTION.; ... New Batch 1 10/7/2013 9-... User 1 4 10/07/13 09:... User 1
@x BOSTON AN ENEMY AT GREEN KNOW. 1964 [J Book (.. PBIFIC BOS 36313; 36314;... WITCHCRAFT - FICTION.; ju... New Batch 1 10/7/2013 9:... User 1 4 10/07/43 09:... User 1
@ BOSTON THE RIVER AT GREEN KNOW. 1959 [J Book (.. PB/FIC BOS 36308; 36309;... GREAT BRITAIN - FICTION.; ... New Batch 1 10/7/2013 9:... User 1 4 10/07/13 09:... User 1
e BOSTON A STRANGER AT GREEN KNOW. 1961 [3 Book (.. PB/FIC BOS 36311; 36312;... ANIMAL STORIES.; GORILL... New Batch 1 10/7/2013 9-... User 1 4 10/07/43 09:... User 1 i
Active List: Master List Primary Sort: Author, ascending 0 of 134 selected For Help, press F1 NUM

You can also use F1 on your keyboard.
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Help for Current Field

Product Demos & Tutorials...
What's New...
Check for Updates...

About The Cataloger...

Help Topics takes you online to
www.mitinet.com.

When you first install MARC Magician,
you may receive an error message when
you try to access the Help Menu.

This happens because Microsoft does not
support the WinHIp32.exe help program
in the newer versions of Windows.

Go to the FAQ on Failure to Install Help
to find instructions for installing a work
around that will allow you access to the
Help Topics.
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Help Topics

File Edit Bookmark Options Help

Helplopicsl I Print | Home lglossaly

Cataloger's Reference — Introduction

Welcome to the Cataloger’s Reference. This is a place to turn when you have questions about cataloging.

General cataloging information

The following links take you to general information and advice on cataloging.
W Cataloging electronic books

@ Main entries

@ Titles

o Once Help Topics is available,

asiess click on the section you need.

pproximate dates
Detailed field information
The following links take you to information about all of the MARC fields. Each topic includes examples and information about subfields and indicators.
@ Control Information, Numbers, Codes (01X - 09X)
® Main Entries (1XX)
@ Title and Title-Related Fields (20X - 24X)
@ Edition, Imprint, Etc. (250 - 28X)

@ Physical Description, Etc. (3XX)
W Series Statements (4XX)

@ Notes (5XX)

@ Subject Access Fields (6XX)

ded Entries (700 - 75X)

@ Linking Entries (76X - 78X)

W Series Added Entries (800 - 840)

W Holdings, Alternate Graphics, Etc (841 - 88X)

Abbreviations
A

reviations

R2 State A

@ USPS State Abbreviations



Help Topics, Continued

For each Help Topic, there are instructions and examples. Please note
that these are also visible right on screen as you work in Cataloger.

- -
MARC Magician
- File Edit Bookmark Options Help
Professlonal Helplapicsl Back | Print | Home IQlossavy

Cataloging electronic books
How- I o = This topic gives instructions on how to use MARC Magician to create properly coded MARC records for electronic books. It also provides guidelines on some of the fields commonly used in this type of record.

To create a properly coded record for an electronic book

Hel p Featu res & 1. Create a new record based on the Book (not atlas or songbook) template.

2. Fill in the descriptive information in the record window.

Auto Error checkin The book template does not include all of the fields commonly used for electronic books, so you will have to add the ones you need. Ho
g 3. On the Record menu, click Control Fields. Click the Form of Item tab, and then choose electronic.

This will set the GMD (245$h) to [electronic resource].

4. Save the record.
Bibliographic field overview

245$h (Title Statement - General Material Designation)
For electronic books and serials, the GMD should automatically be set to [electronic resource]. See step 3 above.

256 (Computer File Characteristics)
Use this field in all bibliographic records for electronic books, but do not include detailed information such as the number of files and the file size, because this data may vary greatly from the form in which it is received to the form in which it
is used and stored.

Example: 256 $aComputer data

260 (Publication, Distribution, Etc.)

All electronic books are considered to be published. Look for a formal statement of publication that includes place, publisher, and date. If no publisher information is readily available in the item, follow the AACR2R rules and guidelines about
this area.

Example: 260 $aBoulder, Colo. : $bNetLibrary, Inc., $c1999

300 (Physical Description)
Do not use this field for electronic books, because there is no physical item being cataloged (see AACR2R 9.5, footnote 3).

500 (General Note)
In this note, specify where you obtained the title you entered in the 245 field. You may also use a 500 field to provide brief information on the nature or scope of the file, unless this is already apparent from the rest of the description.
Example: 500 $aTitle from title frame

533 (Reproduction Note)
Give all other details relating to the reproduction and its ication/availability, including the format of the reproduction, dates of publication, place and name of the agency responsible for the reproduction, date of reproduction, physical
description of the reproduction if different from the original, series statement of the reproduction (if applicable), and notes relating to the reproduction (if applicable).

Example: 533 $aElectronic reproduction : $bBoulder, Colo. $cNetLibrary, Inc. $d2000

538 (System Details Note)
Use this field to record the mode of access, in general terms. A separate local access field (856) provides detailed coded information for access. Begin the note with the words Mode of access:
Example: 538 $aMode of acccess: World Wide Web

You may also use this field to indicate the type of computer, amount of memory, and any additional programs or special hardware required to view the electronic book. For this type of note, begin with the words System requirements:

856 (Electronic Location and Access)
Use this field to record the information required to locate the electronic book, such as the address on the Internet (URL).
Example: 856 $uhttp://www.netlibrary.com/summary.asp?ID=2063

Mitinet Library Services
www.mitinet.com
800-824-6272



4 A Cataloging Help
. You don’'t have to leave Cataloger to access the Help features.
MARC Magician 9 P
Professional
How-To: , —
I\ Cataloger - The answer-backer cure — =B = X
Help Features & File Edit View Record Field Subfield Template Window Help

Pe|B| 4[| | MBlu|® |d|c|n|v| n[E[1]ss] 2]

Auto Error Checking .

[\ The answer-backer cure [?]@ 028 (Publisher Number)
028 ﬁl << Typethe $a (Publisher number) here A
b

_245| a| The answer-backer cure
_h|[gideorecording] :
b The chores cure /

_c| MCA Family Entertainment ; Think Entertainment ; South Pacific Pictures ; Shelley Duvall presents ; directed by Wayne Tourell ; written by Philip La Zebnik, John = oheld:
Schyeinfeld . Sa (Publisher number)

248| a| Chores cure

_260| a| Universal City, CA : /
b niver. me Video , = s =
Rl e Information panels identify what content /

300 a| 1 videocassette (57 min.) :

T belongs in that specific field.

x

il 12in . Active Emor Checking:
il
440| a| Mrs. Piggle-Wiggle
500| a| Based on the books by Betty McDonald . -
Tips & E I ific to the field
’ -
you're in at the moment.
I
X Tips: Examples:
Transcribe the producer or distributor’s number 0248
including any letters or numbers as given on HSV 5274
the item. If there is more than one number., give
all. If the numbering is consecttive, give
inclusive numbers.
For Help, press F1 Template: Videorecording - VHS |Material type: Videorecording - VHS NUM ¥

Mitinet Library Services
www.mitinet.com
800-824-6272
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Auto Error Checking

To set up Auto Error Checking.

Use Active Error Checking options to
define which issues you want to be notified
about and which issues you want to ignore.

Click the Options button on the toolbar and
select Active Error Checking.

There are three levels of error checking:

Cataloging | Views Active Enor Checking | Speling Checker | Templates | Import | Advanced |
Different catalogers have diferent standards for what they consider "comect”” MARC records:

Active Emor Checking helps you ensure that your records meet all of your cataloging standards before
you expoit them. Select what sorts of ommisions and mistakes you consider export emors

Foun things are akways export enors: & missing title, too many titles., too many main entries. and flelds o
sublields that are too long.

*  Basid

All omissions and ertors aie ignored except the fous that are shways export ermors

* € Texas Library Connection
Records that do not meet the Texas Library Connection requirements cannot be expoited. For
all other omissions and emors, you can make your own seitings for how the program should
handle them. The Texas Library Connection requires that all records have a conect title, name
of publisher, date of publication, and extent desciiption. The title must not be in all upper case:

» " Custom
You can make your own settings for how the program should handle omissions and enors in
records — whether to ignore them, issue wamings, of reat them a: export enors

Basic, Texas Library Connection, and

Custom.

Active Emor Checking Settings: Custom

Mo Elhu physical details
Ma dimensions

Control fields:
Place of public. not set
Date not set

Running time not <2t

Mo notes

No subjects

Mo holdings information

Title in all upper case
Mon-MARL fields or subfields

Too many nonTepeatable fields 1 export enar
or subfields

0K | Concel | Hep

The Active Error Checking Settings dialog box
shows everything MARC Magician can flag.

For most issues, choose one of three options:
export error, warning, or ignore. There are no
notifications for issues set to ignore. Warnings
and export errors are distinguished In various
ways in the main window, the Cataloger, and the
Record Viewer.

Notice that some issues are always export
errors. These are serious problems that should
always be corrected. How you set the other
issues is up to you.



Checking Panel.
MARC Magician

Professional
How-To:
Help Features & i8] 11> le]-| Alw ] alalclxlv] %izlx] sjs) 1]
Auto Error Checking | e = o

028 40| a| Typethe $a (Publisher number) here

MM Cataloger - The answer-backer cure - - ey -

b

_245] 04 a The answer-backer cure
_h| [gideorecording]
_b] The chores cure

c| MCA Family Entertainment ; Think Entertainment ; South Pacific Pictures ; Shelley Duvall presents ; directed by Wayne Tourell ; written by Philip La Zebnik, John |2 bl
Schyeinfeld S (Publsher number)

_248] 2_| 3| Chores cure

60| __| a| Universal City, CA
_bJ MCA Universal Home Video ,
<|c1994

30| __| |1 videocassette (57 min.) :
bsd., col. ;

x
<l12in Active Emor Checking:
|
_440|_0| a| Mrs. Piggle-Wiggle |
500 _| a| Based on the books by Betty McDonald . ‘

X Tips: X Examples:
Transcribe the producer or distributor's number
e

0248
HSV 5274

all. f the numbering is consecutive, give
inclusive numbers.

For Help, press F1

Possible errors are shown in the Active Error Checking
box as you catalog.

Mitinet Library Services
www.mitinet.com
800-824-6272

Active Error Window In Cataloger

If you don't see the Active Error Checking panel, it may be turned off.
4 ‘ Turn it on by opening the View menu and clicking Active Error

Active Emor Checking:

no holdings

Black text
indicates a
warning.

Active Emor Checking:

unknown place of pub (control
fields).. 935is not a MARC field
835 Sais not 3 MARC subfield;
935 Scis not a MARC subfield:;
§70is not a MARC field; S70

not a MARC subfield; unknown
pub. date (control fields); no

00 eA~)

dimensions (300 Sc)

Red text
indicates an
export error.

Sa
is not a MARC subfield: 970 $fi

IS
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Active Error Window in the Main Window
On a list the Active Error Checking indicators shows up as color

signals in the first column of the list.

@ OK CLEARY
@x OK CLEARY
@x OK CLEARY
@ OK CLEARY
@% OK CLEARY
@ OK CLEARY
@x OK COLLIER

Records with no errors will

RUNAWAY RALPH / by Beverly Cleary.

RUNAWAY RALPH / by Beverly Cleary

RUNAWAY RALPH / by Beverly Cleary.

Socks / by Beverly Cleary.
Socks / by Beverly Cleary.
Socks / by Beverly Cleary.
MY BROTHER SAM IS DEAD

have a green “OK".

To see what the specific error is for any record, click on the record

£\ Wamni.. McAulay, David ~ Mill.
A\ Warni.. McAulay, David ~ Mill.
A\ Wamni.. McAulay, David ~ Mill.
£\ Wami.. McAulay, David ~ Pyramid.
A\ Wami.. McAulay, David ~ Pyramid
A\ Warni.. McAulay, David ~ Pyramid

Records with warnings will
have a yellow triangle.

@ Error
@ Error
@ Error
@ Error
@ Error
@ Error
@ Error

Achebe, Chinua No lonéer at ease / Chinua Achebe.
Achebe, Chinua  Things fall apart.
Achebe, Chinua  Things fall apart.

HITCHIKER'S GUIDE TO THE GALAXY.
HITCHIKER'S GUIDE TO THE GALAXY.

LIFE, THE UNIVERSE AND EVERYTHI...
LIFE, THE UNIVERSE AND EVERYTHI...

1994
1959
1959
1979
1979
1982
1982

Records with export errors
will have a red circle.

to open it in Record Viewer and look at the comments in the Active

Error Checking box in the lower right corner.
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Important

Active Error Checking is very helpful,
but it isn’t foolproof.

Records showing an OK may have other
problems that MARC Magician won't flag,
and records that show export errors or
warnings may actually be correct.

For example...

If you have Active Error Checking set to flag
a missing publication date, serials (which
usually don't have this subfield) will show
errors or warnings even though they are
actually correct.

Best practice is to check each record for
errors as It's created, review global edits
carefully, and use Spell Check.



4V 4 This is the end of our MARC Magician
Professional tutorial on Help Features

MARC Magician -
Professional and Auto Error Checking.
Help“g;f‘:;s . To find out more about other
u - =
Auto Error Checking MARC Magician tools and features:

—> use the built-in help button identified by a ?

—> check out our other How-To slideshows
on the MARC Magician tutorial page HERE

— or read the “MARC Magician User's Guide”
available to review or download HERE

Mitinet Library Services
www.mitinet.com
800-824-6272



